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Important Information

Intended use of this software

This software has been designed to permit recording images of the interior of a machine, 
facility or building, which cannot be observed directly from the exterior, using Evident industrial 
endoscope to display the observed images and measurement results on the PC screen, create 
reports of recorded still images and perform re-measurements.

Instruction manual

Before using the software, be sure to carefully read this instruction manual, the software license 
agreement, the instruction manual for Evident industrial endoscope to be used and instruction 
manuals for your PC and OS.

If you have any questions about the information provided in this manual, please contact Evident.

Target images of this software

This software applies to images recorded using following products.
• Industrial endoscope IPLEX series, Series C

This software can create the report files of only images recorded using following products.
• Industrial endoscope IPLEX (FX(IV8000-2), L series, R series, UltraLite, NX, G series, G Lite 

series, GAir), Series C
In order to create the report files, the report environment files and report templates are required.  
For details, please contact Evident.

Measurement accuracy

As the stereo measurement function of this software utilizes image processing, the measure-
ment accuracy is affected by the quality of the image used. Since the image quality is variable 
depending on the surface conditions of the measurement target and on the imaging conditions 
such as the brightness, Evident does not guarantee the accuracy of the results obtained with this 
measurement. Each customer is requested to obtain the measurement accuracy by repeating 
testing, etc. To obtain the more accurate results from the measurements using Evident industrial 
endoscope, it is recommended to perform measurements using several images captured from 
various angles.
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11 Starting, Exiting

1-1  Starting

1-2  Exiting

Copy the InHelpVIEWER_eng.exe to the place you want to store it, such as on an external 
memory or the hard disk of your computer, then double click it to start the software.

Click the [Close] button  in the top right corner of the Main window. Alternately, click [Exit] in 
the [File] menu.
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Following operations are available in the Main window. (Pages for reference)

• Display the hierarchical structure of files and folders in the PC (page 5).
• Copy, move (page 7), rename (page 7) or delete (page 8) files and folders.
• Create folders (page 8).
• Rename all files as a batch (page 9).
• Group files (page 11).
• Search files (page 12).
• Change the image information (page 13).
• Convert the format of the image acquired with the digital camera, etc. (page 15).
• Print still images (page 18).
• Create reports (page 19).

22 Main window
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 2-1  To minimize the window or restore the original size

6
7
8

9

10

11

To minimize the window and display it as a button on the taskbar, click the [Minimize] button .
To restore the minimized window to its original size, click the [OLYMPUS InHelp VIEWER] button 

 on the taskbar.

1
2
3

4

5

No. Name

1 Title bar

2 Menu bar

3 Toolbar

4 Folder tree area

5 File list area

6 Address bar

No. Name

7 View option area

8 Status display area

9 Folder thumbnail area

10 File thumbnail area

11 Status bar

· Still images recorded using the Evident industrial endoscope are displayed 
together with the image titles and sequential numbers below them.

TIP
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You can minimize or maximize the display by clicking the [File List/Search] button 
 in the file list area or the file search area.

You can switch between the file list area and the file search area in the [List/Search] tab.

File list area File search area

 2-2  To view the folder hierarchy

To view the files on a drive or in a folder in the file list area and file thumbnail area, click the drive 
or folder name in the folder tree area.
Subfolders are displayed in the folder thumbnail area. Alternately, clicking the plus (+) symbol on 
the left of the folder name in the folder tree area or double clicking the folder name displays the 
subfolders.
The boundary lines delimiting the folder tree area, folder thumbnail area and file thumbnail area 
can be moved by dragging them.
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2-3  To select multiple files

To select multiple files that are listed consecutively in the file list area or file thumbnail area, click 
the first file in the sequence, press and hold down the [Shift] key, and then click the last file. To 
select multiple files that are not consecutive, press and hold down the [Ctrl] key, and then click 
each file.
To select all files in the selected folder, click [Select All] in the [Edit] menu.

2-4  To view a still image

After selecting the desired file in the file list area or file thumbnail area, click [Open] in the [File] 

menu or click the [Open] button  on the toolbar, or simply press the [Enter] key. If the selected 
file is a still image file that can be viewed with this software, the Image window opens showing 
the still image. If the Image window has already been opened, the still image is displayed in the 
existing window.
A still image can also be displayed by double-clicking the filename you want to open.

2-5  To play a movie

After selecting the desired movie file in the file list area or file thumbnail area, open the [File] 

menu and click [Open], or click the [Open] button  on the toolbar, or press the [Enter] key. If 
the selected file is a movie file playable on the PC, a player such as the Windows Media Player 
is activated to play back the movie.
A movie can also be played back by double-clicking the desired movie file.

2-6  To play a sound file

After selecting the desired sound file in the file list area or file thumbnail area, click [Open] in the 

[File] menu or click the [Open] button  on the toolbar, or simply press the [Enter] key. If the 
PC is capable of playing back the sound file, the software such as Windows Media Player is 
activated automatically to play back the sound.
The sound can also be played back by double-clicking the desired sound file.
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2-7  To copy or move a file(s) or folder

Click the file or folder you want to copy or move.
Click [Copy] in the [Edit] menu or click the [Copy] button  in the toolbar. To move the item, click 
[Cut] in the [Edit] menu or click the [Cut] button  in the toolbar.
Open the folder or drive where you want to copy or move the item.
Click [Paste] in the [Edit] menu or click the [Paste] button  in the toolbar.
You can copy or move multiple files or folders at the same time.

2-8  To drag & drop a file

In the file list area or file thumbnail area, point the file you want to drag & drop with the mouse, 
and drag & drop the file into the destination folder in the folder tree area. If the destination folder 
is located on the same drive as the file, the file will be moved to the destination folder. If the desti-
nation folder is located on a different drive, the file will be copied instead of being moved.
If you want to copy the file to another folder in the same drive, press the [Ctrl] key and drag & 
drop while keeping the key pressed.
This software does not support the drag & drop operation while keeping the [Shift] key pressed.

2-9  To rename a file or folder

Click the file or folder you want to rename.
In the [File] menu, click [Rename].
Type the new name, and then press the [Enter] key.
The following characters cannot be used in the file names and folder names:
\ / : * ? " < > |
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 2-10  To create a new folder

 2-11  To delete a file(s) or folder

Click the drive or folder in which you want to create a new folder.
Click [New Folder] in the [File] menu or click the [New folder] button  in the toolbar.
The "New Folder" dialog box appears.

Type the name of the new folder in [Enter Folder Name] and click the [Create Folder] button.

Click the file or folder you want to delete.
Click [Delete] in the [File] menu or click the [Delete] button  in the toolbar, or simply press the 
[Del] key. The [Delete File] or [Delete Folder] confirmation message appears.
Click the [Yes] button to delete the file or folder.
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 2-12 To rename image files as a batch

Names of all still image files recorded using the Evident industrial endoscope and names of all 
movie files paired with such still images in the selected folder can be renamed as a batch ac-
cording to the specified rules.

Make following settings:

To change the folder in which the files are saved, select the [Browse] button.

To rename a subfolder you newly create, click the [Subfolder] text box and input texts.

To convert the file name using the title information attached to the still images, click the 
[Title] radio button under the Rename Format.

To convert the file name using “file name + a 5-digit sequential number”, click the [Se-
quence] radio button and input a file name in the text box.

When the setting is completed, click the [Start] button.

· As a new folder is created under the save destination folder you specified and you 
copy the files for renaming, the original files will not be renamed.

· To rename the file by replacing the blank in the title with the underscore (_), click the 
[Replace Blank to Underscore] check box to put a check mark. To rename the file 
without blank, click the check mark to remove the check mark.

1

2

3

4

TIP

 To convert a file name by title or sequential number
Open the folder that contains files you want to rename as a batch, and click the [Convert File-
name (Title, Sequence number)] in the [File] menu. Alternatively, right-click the folder and click the 
[Convert Filename (Title, Sequence number)].



10

 To convert a file name by folder name
Open the folder that contains files you want to rename as a batch, and click the [Convert File-
name (Folder Name)] in the [File] menu. Alternatively, right-click the folder and click the [Convert 
Filename (Folder Name)].
The “Confirmation” dialog box appears. Clicking [Yes] renames the file to the name which is com-
posed of the selected folder name and a five digit sequential number. The file name containing 
the inspection results will be renamed to the name that is composed of the selected folder 
name, a five digit sequential number and a letter from A to D.

 · Names of still image files in the selected folder and names of movie files paired 
with those still images are converted directly. Files before conversion are not 
backed up.

TIP

2-13 To select how a thumbnail is displayed

The thumbnail display method can be switched among the normal view mode, expansion view 
mode or lower view mode.

Normal view mode
This mode allows you to browse all files and folders on the PC and the network.

Expansion view mode
This mode allows you to browse only still images recorded using the Evident industrial 
endoscope and display the file name, title, sequential number as well as the inspection results 
comments and the captured date.

Lower view mode
This mode, in addition to the contents in the expansion view mode, displays the check box 
to select whether to output the image in a report or not. This mode allows you to display still 
images only in the currently selected folder and folders directly beneath it. Because of this, the 
folder thumbnail area cannot be browsed. Putting a check mark in the check box selects the 
image to be output in a report.

To switch the view mode, click the [Normal View] button , [Expansion View] button , or 
[Lower View] button  in the view option area.
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2-14  To group images

The still images recorded using the Evident industrial endoscope can be grouped based on the 
shared information. You can group files displayed in the file list area or the file thumbnail area.
In the normal view mode or the expansion view mode, you can group the data by TITLE or DATE. 
In the lower view mode, you can group the data by ALL, NO MARK, A, B, C, or D in inspection 
results, or presence of a check mark (Add to report).
To group the data, click a folder and click the buttons in the view option area.

 · You can ungroup the grouped files in either of following methods.
 - Select a different folder in the folder tree area.
 - In the file search area, click the [Reset] button.
 - When in the normal view mode or the expansion view mode, select the lower 

view mode.
 - When in the lower view mode, select the normal view mode or the expansion 

view mode.

TIP
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2-15  To search images

The still images recorded using the Evident industrial endoscope can be searched.
Click the folder in the range you want to search in the folder tree area.  
The selected folder and its all subfolders will be searched.
Click the [Search] tab in the file list area to display the search criteria setup screen.
Set the search criteria:

To input the character string of a file name or folder name, click the [File or folder name] 
text box and input texts.

To input the character string contained in a file, click the [A word or phrase in the file] 
text box and input texts.

To make the title setting, select a title from the [Title] drop-down list and click the check 
box to put a check mark.

To specify the range of the captured date, click the calendar button  in the [from] and 
[to] date setting column to select the date in the calendar, and click the check box to 
put a check mark. The date can be directly inputted in the date setting column.

You can obtain the content of the drop-down list by clicking the [Search condition] button.
When the search criteria setup is completed, click the [Search] button. The search result will be 
displayed in the file thumbnail area and the file list area. The number of files in the search result 
is displayed in the view option area.
Click the [Reset] button to clear the search result. In addition, to cancel the search in the middle 
of the operation, click the [Stop] button.

 · An asterisk (*) can be used as a wild card that works as one or more characters.

1

2

3

4

TIP
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 2-16  To modify the image information

You can change the inspection results, titles, sequential numbers and comments of the still im-
ages that were recorded using the Evident industrial endoscope.

Click the [Edit] button in the upper right area of the thumbnails in the file thumbnail area in the 
expansion view mode or the lower view mode, or right-click the still image and click [Edit Image 
Information].
The "Edit Image Information" dialog box appears.

 To modify results, titles or sequential numbers

Perform following operations.

Click the [Load CSV file] button to load the report environment file. Then, inspection 
results are displayed and the selections are added to the [Title] drop-down list.

To modify the inspection results, click the check box for A to D, or X to put a check mark.

To modify the title, select a title from the [Title] drop-down list.

To modify the sequential number, click the [Seq.No] text box to input 3 digit number.

When the modification is completed, click the [OK] button.

1

2

3

4



14

Click the [Edit] button in the lower right area of the thumbnails in the file thumbnail area in the 
expansion view mode or the lower view mode, or right-click the still image and click [Edit com-
ments].
The "Edit comments" dialog box appears.

 Modifying the comments

Perform following operations.
• To modify the comment, click the [Comments] text box and input texts.

When the modification is completed, click the [OK] button.



15

InHelp VIEWER

 2-17  To import an image file

You can convert still images (BMP, JPEG, TIFF format) taken with a digital camera to the same 
format as still images recorded using the Evident industrial endoscope. 
The original file is not modified because the file is copied before being modified.
Loading the report environment file will set the title and the inspection result per each still image.
Perform following operations.

Copy the still image to be imported to the folder to be output in a report.

Select the folder in which the still image you want to import is stored and click the 
[IMPORT] button  in the view option area.

The “Import (Conversion of digital camera pictures)” dialog box appears.

1

2

Perform following operations.
• Select a report environment file.

When the setting is completed, click the [Next] button.

 Setting a title and inspection result to the image to be imported
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The “Import (Conversion of digital camera pictures)” dialog box appears.

Make following settings.

Select a title from the [Title] drop-down list.

Select a result from the [Result (File Mark)] drop-down list.

When the setting is completed, click the [Next] button. The conversion of the still image format 
starts in the ascending order of the file name. The converted still image file is saved in the cur-
rently selected folder. The file name is composed of the name of the selected folder plus a five 
digit sequential number and if a result from A to D has been selected in [Result (File Mark)], a 
letter from A to D is appended.

1

2

Make following settings.

In the "Import (Conversion of digital camera pictures)" dialog box, click the [Do Not set 
a title or inspection result] check box to put a check mark.

Click the [Next] button.

The "Confirmation" dialog box appears.

Clicking [Yes] starts the conversion of the still image format in the ascending order of 
the file name.

The converted still image file is saved in the currently selected folder. The file name is composed 
of the name of the currently selected folder and a five digit sequential number.

1

2

3

 Not setting a title and inspection result when importing a still im-
age file
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2-18  To modify the print layout

The print layout can be modified.
Click the [Print Layout] on the [Print] menu.
The "Print Layout" dialog box appears.

Make following settings.

To modify the print layout, select the [Print Layout] button.

To modify the print position of the page number, select a position from the [Print Page 
Number] drop-down list.

To modify the print position of the printed date, select a position from the [Print Date] 
drop-down list.

When the setting is completed, click the [OK] button.

1

2

3
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2-19  To preview a printed image

2-20  To print an image

The print image can be previewed according to the print layout.
Select the still image you want to preview. When no still images are specified, all images in the 
open folder will be previewed.
Click the [Preview] on the [Print] menu.
The print image is previewed according to the print layout setting.
On the preview page, you can:

click the [Next Page] or [Prev Page] button to select a page,

click the [Two Page] button to switch to the double-page mode from the single-page 
mode. To return to the single-page mode, click the [One Page] button, and

click the [Zoom In] or [Zoom Out] button to zoom in or out the print preview page.

To print from the preview page, click the [Print] button.  
The "Print" dialog box opens for you to execute the printing.
To close the preview page, click the [Close] button. The Main window opens.

1

2

3

The image can be printed according to its print layout.
Select the still image you want to print. When no still images are specified, all images in the 
open folder will be printed.
Click [Print] on the [Print] menu.
The "Print" dialog box appears.
Change the printer setting as needed.
Click the [OK] button to print the image according to the print layout setting.

 · To use the print function, the printer setting is required. Refer to the instruction 
manual of the printer to make appropriate settings.

TIP
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 2-21  To create a report file

You can create the report files from the still images recorded using the Evident industrial 
endoscope. To create the report files, the report environment files and the report templates are 
required.
Select the folder containing the still image you want to output in a report. Then, click the [Lower 
view] button  in the view option area to switch the thumbnail view method to the lower view 
mode.
Click [Report Generation] on the [Report] menu or click the [Report Generation] button  on the 
toolbar.

Perform following operations.

Click the [Select CSV file] button and select a report environment file for the type of 
report file you want to create.

Click the [Select DOT file] button and select a report template file for the type of report 
file you want to create.

To select an still image to use in the report, click the [All images in the folder] radio 
button or the [Selected images] radio button.

1

2

3

The "Report Generation Step1" dialog box appears.
In Report Generation Step1, select the report environment file, report template file and still images 
to use in the report.

  Report Generation Step1
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3 -1 Clicking the [All images in the folder] radio button changes the folder of still im-
ages ti use in the report.

3 -2 Clicking the [Selected images] radio button selects the still images that have a 
check mark in the check box in the lower left corners of their thumbnail images 
in the lower view mode to be output in the report. Clicking on an still image in 
the Main window opens the Image window. You can select whether to output 
the still image or not in a report on a large screen. Refer to "3-1  To open the 
Image window" (page 29) and "3-10  To change what is output in a report" 
(page 32).

· Copying still images recorded using the Evident industrial endoscope or still images 
taken with a digital camera (JPG, BMP, TIFF, PNG) to the “00_DataPlate” folder outputs 
them to the report item “Data Plate” in the report file.

· When selecting the CSV file in 1 , if the report template files having the same name 
in the folder containing the report environment files, the report template file is selected 
automatically and the file name is displayed in [Report template file].

When the setting is completed, click the [Next] button.

TIP

The "Report Generation Step2" dialog box appears.
In Report Generation Step2, select and edit the content to be output to the “Report Header” of 
the template file.

 Report Generation Step2
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Perform following operations.

To use a report header, click the [Insert report header] check box to put a check mark.

To use an existing report header file, click the [Select file] button and select a report 
header file.

To edit the title, click a grid on the [Report header item] row and input texts.

To modify the data, select the data from the [Data] drop-down list. Or, to edit the data, 
click a grid on the [Data] row and input texts.

 · If you click the [Insert report header] check box to remove the check mark, a report 
header will not be output to the report file.

 · If InHelpVIEWER_eng.exe is in the same folder as the “ReportHeader.txt” file, that file 
is automatically loaded when the “Report Generation Step2” dialog box appears, and 
the content appears in the title and the data.

 · You can edit the report header file in advance. See "2-22  To edit a report header" 
(page 26) for information on how to edit the file.

 · The number of files containing still images to use for reports appears in the title bar of 
the window. However, the number of files in the "00_DataPlate" folder is not included.

When the setting is completed, click the [Next] button.

1

2

3

4

TIP
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The "Report Generation Step3" dialog box appears.
In Report Generation Step3, select and edit the content to be output to the “Inspection Header” 
of the template file. The inspection header can be set up to four headers.

 Report Generation Step3

Perform following operations.

To use an inspection header, click the [Insert inspection header] check box to put a 
check mark.
To use an existing inspection header file, click the [Select file] button to select a inspec-
tion header file.
To edit the title, click a grid on the [Inspection header item] row and input texts.

To modify the data, select the data from the [Data] drop-down list. Or, to edit the data, 
click a grid on the [Data] row and input texts. 
Clicking either one of [1] to [4] buttons changes the inspection header.

1

2

3

4
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The "Report Generation Step4" dialog box appears.
In Report Generation Step4, select the output method for folders in which no still images are 
stored. Also, set the details of the report output.

 Report Generation Step4

· If you click the [Insert inspection header] check box to remove the check mark, an 
inspection header will not be output to the report file.

· If "InspectionHeader.txt" or "InspectionHeader4.txt" file from "InspectionHeader2.txt" are 
in the same folder as "InHelpVIEWER_eng.exe", the files are loaded automatically to 
Table 1 to 4 of the inspection header and the contents appear in [Inspection header 
item] and [Data].

· You can edit the inspection header file in advance. See "2-23  To edit a inspection 
header" (page 27) for information on how to edit the file.

When the setting is completed, click the [Next] button.

TIP
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Perform following operations.

To output the information to a report from a folder that has no still images saved in it, 
click the [Insert no image display option] check box to put a check mark.

Click the [No findings] radio button to output “No Photograph Available” as a replacement 
for report files with no still images if there are no still images stored in the folder. To output 
a report file as not inspected without outputting still images, click the [Not inspected] 
radio button. You can also click the [No list] radio button to not output to a report file.

Clicking the [Options] button displays the "Options" dialog box.

1

2

3
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You can make following settings in the "Options" dialog box.

3 -1 If you click the [Activate the Page Break function] check box to remove the check 
mark, the number of pages of inspection result images that are output to the 
report file is reduced as much as possible.

3 -2 If you click the [Output the specified report item name] check box to put a check 
mark, the report is output with the report item name described in the report 
environment file.

3 -3 If you click the [Emphasis output the inspection result] check box to put a check 
mark, the report is output by coloring the frame line of the inspected image and 
the texts of inspection results according to the color information described in 
the report environment file.

3 -4 If you click the [Output the specified character string] check box to put a check 
mark, the summary items of the report file are output using the texts described 
in the report environment file.

3 -5 If you click the [Add the related movie file link] check box to put a check mark 
and specify the output destination of the movie file, the hyper link of the movie 
file paired with the still image file to output to the report will be appended.

 · If you click the [Insert no image display option] check box to remove the check 
mark, the information in the folder in which no still images are saved is not output 
on the page of the inspected image in the report file.

When the setting is completed, click the [Generate] button. Microsoft Word is activated to start 
creating a report file. The report creation progress dialog box appears while creating a report.
If you click the [Cancel] button at this point, you can cancel the creation of the report.
After the report file has been created, the generated report is displayed in Microsoft Word.

 · Microsoft Word is used to create a report file. If it is not installed, the report function 
is unavailable. See "7 Specifications" (page 66) for applicable versions of Microsoft 
Word.

 · When exiting Microsoft.Word,the message for confirming whether to save the tem-
plate file may appear. In this case, click the [No] button.

TIP

TIP
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 2-22  To edit a report header

You can edit the report header file that is used to create a report file.
Click [Report Header Edit] in the [Report] menu.
The “Edit report header data” dialog box appears.

Perform following operations.

To edit the report header file you saved, click the [Load] button to select the file.

To edit the title, click a grid on the [Report header item] row.

To edit the data, click a grid on the [Data] row.

· Up to 100 data can be set per title and up to 12 sets can be created in total.

To delete all displayed information, click the [Clear all] button.
When the report header has been edited, click the [Save] button to name the file and save it.

1

2

3

TIP
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 2-23  To edit a inspection header

You can edit the inspection header file that is used to create a report file.
Click [Inspection Header Edit] in the [Report] menu.
The “Edit inspection header data” dialog box appears.

Perform following operations.

To edit the inspection header file you saved, click the [Load] button to select the file.

To edit the title, click a grid on the [Inspection header item] row.

To edit the data, click a grid on the [Data] row.

· Up to 100 data can be set per title and up to 20 sets can be created in total.

To delete all displayed information, click the [Clear all] button.
When the inspection header has been edited, click the [Save] button to name the file and save it.

1

2

3

TIP
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33 Image window

Following operations are available in the Image window. (Pages for reference)

• Play back (page 29), rotate (page 34), zoom in or zoom out (page 34) a still image.
• Play two still images simultaneously (page 36).
• Save a still image by print screen (JPEG only)(page 31).
• Copy a still image on the screen (page 31), drag&drop to other application software*(page 

32)
• Delete a still image (page 32)
• Select a still image to output to the report (page 32).
• Trimming of a still image (output to report)(page 32).
• Edit the image information (page 33).
• Edit the note information (page 33).
• Display measurement results(page 36).

* Provided that the application software is drag & drop compatible.
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 3-1  To open the Image window

After selecting the desired file in the file list area or file thumbnail area, click [Open] in the [File] 

menu or click the [Open] button  on the toolbar, or simply press the [Enter] key. If the selected 
file is a still image file that can be viewed with this software, the Image window opens showing 
the still image.
A still image can also be displayed by double-clicking the file you want to open.
To close the Image window, click the [Close] button  in the top right corner of the Image 
window.

3

4

1

2

No. Name

1 Title bar

2 Still image display area

3 Still image operation area

No. Name

4
Image information/Note/Measure-
ment result area

5 Trimming frame

5
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3-2  To switch still images

To view the previous image in the current file thumbnail area, click the [Previous] button  in the 
still image operation area.
To view the next image in the current file thumbnail area, click the [Next] button  in the still 
image operation area.

Clicking the [Image information/Note/Measurement result] tab switches either to the image infor-
mation view, notes view or measurement result view.

Image information area Note information area Measurement result area

3-3  To perform stereo re-measurement

While the stereo measurement target image* is displayed in the Image window, click the [Re-

Measure] button  in the still image operation area. The Stereo Measurement window 
will open and you can perform the stereo re-measurement.

* See "4-1  Stereo measurement target image" (page 38) for the stereo measurement target 
image.

When the stereo measurement target image stored in a removable medium 
such as a CF card, USB memory or SD card is displayed, the medium should be 
kept connected until the stereo re-measurement completes.

TIP



31

InHelp VIEWER

3-6  To save a screen

Click the [Screen capture] button  in the still image operation area. The “Save As” dialog box 
appears.

Specify the save destination location and input the filename. The file type is JPEG only.

Click the [Save] button in the dialog box. The displayed screen is saved as a JPEG format file.

3-5  To save an image information

Click the [Save image information (inspection result, title, NOTE)] button  in the still image 
operation area.
Save the image information (inspection result, title, sequential number, comment) and the note 
information to the image being displayed or selected.

When the "Confirmation" dialog box appears, click [Yes].

3-7  To copy an image file(s)

Click the [Copy] button  in the still image operation area.  
Start the application software to which you want to copy the still image.  
In the application software, click [Paste]in the [Edit] menu.

3-4  To perform scaler re-measurement

While the scaler measurement target image* is displayed in the Image window, click the [Re-

Measure] button  in the still image operation area. The Scaler Measurement window will 
open and you can perform the scaler re-measurement.

* See "5-1  Scaler measurement target image" (page 55) for the scaler measurement target 
image.

When the scaler measurement target image stored in a removable medium 
such as a CF card, USB memory or SD card is displayed, the medium should be 
kept connected until the scaler re-measurement completes.

TIP
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3-10  To change what is output in a report

Click the [Add to report] check box to put a check mark. The still image with a check mark is 
output in the report. Refer to " Report Generation Step1" (page 19) in "2-21  To create a report 
file" for setting the report output.

3-11  To perform trimming

You can set the print output area of the still image to be output in the report.

Perform following operations.

Click the [Trimming] check box to put a check mark.

Set the trimming area using the mouse to specify four corners of the trimming frame 
displayed on the image.

Click the [Save image information (inspection result, title, NOTE)] button .

 · Clicking the [Trimming] check box to remove a check mark allows you to output 
the full image area displayed in the still image display area in the report.

1

2

3

TIP

3-9  To delete an image

Click the [Delete] button  in the still image operation area. The "Delete File" dialog box ap-
pears.

Click the [Yes] button to delete the current still image and view the next still image displayed in 
the file thumbnail area.

3-8  To drag & drop an image

Start the application software* into which you want to drag & drop the still image.
Press left button of the mouse on the displayed still image, and drag & drop it into the applica-
tion software. You can drag & drop images into application software such as Microsoft Word.
* Provided that the application software is drag & drop compatible.
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3-12  To modify the image information

Click the [Image information] tab in the image information/note/measurement result area to 
confirm or edit the information saved in the still image.

Perform following operations.

To edit the inspection result, select a result from the [Result] drop-down list.

To edit the tile, select a title from the [Title] drop-down list.

To edit the sequential number, click the [Sequence number] text box and input a 3 
digit number.

To edit the comment, click the [Comments] text box and input texts.

 · Click the [Load CSV file] button to select the report environment file. The detail 
information is displayed in the [Result] drop-down list. The selections are added 
to the [Title] drop-down list.

1

2

3

4

TIP

3-13  To edit the note information

Click the [Note] tab in the image information/note/measurement result area to confirm or edit the 
note information saved in the still image. When editing, you can add or delete texts or symbols 
and change the color and size.

Click the [Select color] button  to select the color.

Use the [Size] radio button to select the size.

 Modifying the color

 Modifying the size
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3-15  To modify the displayed image size

The still image can be zoomed in or zoomed out.

Perform following operations.

To display a full view of the still image in the still image display area, click the [Fit in 
window size] check box to put a check mark.

To select the image magnification, click the [Fit in window size] check box to remove 
a check mark.

Click the [Image magnification] button to select the magnification.

 · If a check mark is put to the [Fit in window size] check box or if the image magnifica-
tion is set other than 1X, you cannot edit the note information.

 · If the note information is edited, the check mark of the [Fit in window size] check box 
is removed. The zoom magnification returns back to 1X.

 · The zooming in/out of the still image is not reflected to the report output.

1

2

3

TIP

3-14  To rotate a image

You can set the rotation angle of the still image to output in the report.
Select the [Rotate] radio button to rotate the currently selected still image by each 90 °.
Click the [Save image information (inspection result, title, NOTE)] button .

 · If the angle other than 0 ° is selected, the image information and the note information 
are not overlaid.

 · Clicking the button in the note area makes the [Rotate] radio button select 0 ° and the 
rotation angle of the still image returns back to 0 °.

TIP
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 Editing texts or symbols
Perform following operations.

To edit texts, click texts displayed in the still image.  
To input new texts, click the [Text] button  and then click the desired position in the 
still image. 

To edit the circle, click the circle displayed in the still image.  
To input a new circle, click the [Circle] button  and then click the desired position 
in the still image. 

To edit the arrow, click the arrow displayed in the still image.  
To input a new arrow, click the [Upper left arrow] button  or the [Upper right arrow] 
button  and then click the desired position in the still image.

1

2

3

3-16  To overlay the image information

If you click the [Overlay Information] check box to put a check mark, the image information and 
the measurement results are overlaid on the still image.

 · The image information is not reflected to the report output regardless of the presence 
of the check mark.

 · The measurement results are reflected to the report output regardless of the presence 
of the check mark.

TIP

3-17  To overlay the note information

If you click the [Overlay NOTE] check box to put a check mark, the note information is overlaid on 
the still image.

 · The note information is reflected to the report output regardless of the presence of 
the check mark.

TIP
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3-19  To view two images simultaneously

Select two still image files in the file list area or file thumbnail area in the Main window, and then 
open them. The both of still images are displayed in Image window simultaneously.
The desired part of each still image can be viewed by manipulating the horizontal scroll bar 
below the still image or the vertical scroll bar on the right side of the still image.
Clicking either one of two still images with the mouse highlights that still image.
The operations of Re-Measure, Save image information, Copy, Delete, Add to report, Trimming, 
Rotate, display/modify image information, display/modify note information and display measure-
ment results are performed only for the still image which is highlighted.

3-18  To display measurement results

When using the image of which the measurement result is saved, if you click the [Result] tab in 
the image information/note/measurement result area, you can confirm the measurement results 
saved in the still image.

 Modifying text or symbol positions
Move the cursor on the text or symbol displayed in the still image and press the left button of the 
mouse. Then, move the cursor to the desired position and release the left button.

 · While texts or symbols are being selected, if you click the [Clear point] button , the 
selected text or symbol is deleted.

 · Clicking the [Clear all] button  displays the dialog box to confirm the deletion. Click-
ing [Yes] deletes all texts and symbols on the still image.

 · If a check mark is put to the [Fit in window size] check box or if the image magnifica-
tion is set other than 1X, you cannot edit the note information.

 · If the angle other than 0 ° is selected, the image information and the note information 
are not overlaid.

TIP
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44 Stereo Measurement window

Following operations are available in the Stereo Measurement window. (Pages for reference)

• Re-measurement (page 38) ; new measurement (page 45)
• Display (page 43); save (page 50) measurement results.
• Zoom the stereo measurement image (page 39) and cursor position(page 40)
• Modify (page 41) or delete (page 50) the existing reference point or measurement point.
• Save a still image by print screen (JPEG only)(page 51).
• Modify colors or widths of image drawing lines (page 51).
• Display the Mask Line (page 53).
• Modify the unit of measurement results (page 53)
• Modify the cursor shape (page 53)
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 4-1  Stereo measurement target image

 4-2  To open the Stereo Measurement window

Any image recorded by connecting a stereo optical adapter using the Evident industrial endo-
scope can be the target of stereo measurement. (Except for a Print Screen image)
When the stereo measurement target image is used, this software can confirm the stereo mea-
surement results performed by the industrial endoscope by re-measuring the image on PC or 
measure the non-measured parts in the still image.

While the stereo measurement target image is displayed in the Image window, click the [Re-

Measure] button  in the still image operation area. The Stereo Measurement window 
opens displaying the stereo measurement target image.

3

6

7

4

5

8

2

1

No. Name

1 Title bar

2 Measurement area

3 Measurement mode button

4 Still image operation area

No. Name

5 Measured result display area

6 Spot ranging area

7 Operation instruction area

8 Status bar
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If the Stereo Measurement window is already open and the previous measurement results are 
not saved yet, a dialog box appears to confirm if you want to save the measurement results 
together with the stereo measurement target image currently displayed.
Click [Yes] to save the measurement results. (see "4-12  To save new measurement results" (page 
50))
Then, the stereo measurement target image that has been displayed on the Image window is 
displayed newly on the Stereo Measurement window.
If you click [No], the new measurement results are not saved and the stereo measurement target 
image that has been displayed on the Image window is displayed newly on the Stereo Measure-
ment window.

When the stereo measurement target image stored in a removable medium 
such as a CF card, USB memory or SD card is displayed, the medium should be 
kept connected until the stereo re-measurement completes.

 · The next operation to be performed, such as entry of measurement points is 
displayed in the operation instruction area.

NOTE

TIP

4-3  To add a new measurement point

When inputting a measurement point, simply moving the mouse moves the cursor in 1-pixel 
step. Clicking the mouse on the desired position inputs a measurement point at that position.
To input a measurement point more accurately in the desired position, set the zoom window 
magnification in the still image operation area to 2X or higher and move the cursor to the prox-
imity of the target position. When the zoomed-in image is displayed around the cursor (Cursor 
zoom window), move the cursor to the desired position accurately. Then, click the left button of 
the mouse. A measurement point is added to that position. At this time, confirm that the position 
of the corresponding point in the right side measurement area is not too far from the cursor posi-
tion in the left side measurement area.

4-4  To zoom a entire still image

Click the [Image magnification] button in the still image operation area to select the magnifica-
tion. The image magnification can be set to 1X, 2X, 3X or 4X, and the entire still image is zoomed 
according to the setting.
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 4-5  To zoom a cursor position

3

2

5

4

No. Name

1
Zoom window magnification radio 
button

2 Cursor zoom window

3 Cursor

No. Name

4 Corresponding point zoom window

5 Corresponding point

1

Click the [Zoom Window Magnification] button in the still image operation area to select the 
magnification. The zoom magnification can be set to 1X, 2X, 3X or 4X. The still images around 
the current cursor position and the corresponding point are displayed in the cursor zoom 
window and the corresponding point zoom window respectively. When the cursor zoom window 
is displayed, the zoomed image is moved according to the movement of the mouse, and the 
cursor position can be specified.

· Pressing the [PageUp] key or the [PageDown] key allows you to set the magnification 
to 1X, 2X, 3X or 4X.

· When the wheel mouse is used, the magnification can be changed by operating the 
mouse wheel in the left side measurement area. Rotating the wheel allows you to set 
the magnification to 1X, 2X, 3X or 4X.

TIP
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The sub-pixel pointing is a function to specify the measurement position finely at a narrower in-
terval than pixel interval of an still image. While the cursor zoom window is displayed, press and 
hold the mouse left button and move the cursor to the desired point on the still image.

 Sub-pixel pointing

4-6  To modify the existing measurement points and reference point

The positions of existing measurement points and reference points can be modified to obtain 
more accurate measurement results.
To change the measurement point position, place the cursor on the desired point in the left side 
measurement area. With the cursor at that point, hold the mouse left button pressed and move 
the cursor to the desired point, and then release the mouse left button. At this time, confirm that 
the position of the corresponding point in the right side measurement area is not too far from the 
cursor position in the left side measurement area.
If the measurement point is repositioned, the displayed measurement result changes because 
re-measurement is performed immediately.

In the Point to Line and Depth modes, the positions of the reference points can be modified as 
well as the measurement points as shown below. If the reference point position is modified, the 
measurement result changes as well.

Reference point
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When the position of the corresponding point in the right side measurement area is too far from 
the cursor position in the left side measurement area, the position of the corresponding point 
can be modified only in the still image recorded by using IPLEX NX. To change the correspond-
ing point position, place the cursor on the desired point in the right side measurement area. With 
the cursor at that point, hold the mouse left button pressed and move the cursor to the desired 
point, and then release the mouse left button.

 Modifying the corresponding points
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 4-7  To confirm measurement results

The measurement results are displayed in the measurement result display area in the Stereo 
Measurement window as shown below. The measurement results, the object distance and 
auxiliary results are displayed. The object distance indicates the distance from the distal end of 
the scope to the measurement target. The significances of the measurement results and auxiliary 
results in each measurement mode are shown in the table below.

Measurement mode Measurement result Auxiliary result

Distance Distance between two points -

Point to Line Distance from the reference line Distance between the reference 
points

Depth Distance from the reference plane Tilting angles h and v of scope's 
distal end with respect to the refer-
ence plane
(See the picture below. Unit: 
degree)

Lines Total length of folded line Length of last segment in the 
folded line

Area Area of enclosed polygon Circumferential length of the 
enclosed polygon
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4-8  To change the measurement mode

Up to 10 sets of measurements can be performed on the still image being displayed in the 
same measurement mode or in the different measurement mode.
To perform the new measurement in the measurement mode different from the current measure-
ment mode, click the [Measurement mode] button on the upper right part of the Stereo Measure-
ment window to select the measurement mode from the drop-down list.
In the middle of measurement, a dialog box appears to confirm whether or not to delete mea-
surement points in the middle of measurement or reference points.
If you click [Yes], the measurement points in the middle of measurement or reference points are 
deleted and then, the measurement mode is switched.
If you click [No], the measurement mode is not switched and the measurement mode is returned 
to the original measurement mode.
You can select the measurement mode from the table below.

Measurement mode IPLEX NX Other than IPLEX NX

Distance Available Available

Point to Line Available Available

Depth Available Available

Lines Available Available

Area Available Available
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Newly entered point

When two points are entered newly, the distance between two points is measured.

4-9  To start new measurement

When two points are entered, the distance between two points is measured.

 Distance

Two entered points

Two existing points
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In the left side measurement area, enter two points to set a reference line.

 Point to Line

Two points to set a reference line

Enter the point to be measured in the left side measurement area. At this time, confirm that the 
position of the corresponding point in the right side measurement area is not too far from the 
cursor position in the left side measurement area. The distance from the reference line to the 
entered point will be measured.
In the Point to Line mode using IPLEX NX, an offset line that passes through the newly entered 
point and is parallel with the reference line is displayed.

Point to be 
measured

When a point is entered newly, the distance from the reference line to the point is measured.

Newly entered point

Existing point
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In the left side measurement area, enter the three points as the vertexes of the triangle to be 
used as the reference plane.

 Depth

Vertexes of the triangle to be used as the reference plane

Enter the point to be measured in the left side measurement area. At this time, confirm that the 
position of the corresponding point in the right side measurement area is not too far from the 
cursor position in the left side measurement area. The distance from the reference plane to the 
entered point will be measured.

Point to be 
measured

Existing point

When a point is entered newly, the distance from the reference plane to that point is measured.

Newly entered point
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Every time a point is entered newly, the total length of the segments in the continuous folded line 
is measured. Up to 20 measurement points can be entered per folded line.

Click [End point] to complete the current measurement. If another point is entered, the total 
length of the newly created folded line can be measured.

To finish entering the points in the middle of operation, click the [End point] button  in the 
still image operation area. Or, click the right button of the mouse. The menu is displayed.

 Lines
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When the polygon is created, its area is measured.
The polygon can be closed in either method described below.

Method1 After entering the last point of the polygon, click the [End point] button  in the still 
image operation area.  
Or, click the right button of the mouse. When a menu appears, click [End point].

The polygon is closed.

 Area

Last point of polygon

Method2 After entering the last point of the polygon, enter the auxiliary point. At this time, enter 
an auxiliary point so that the segment to the auxiliary point crosses the first segment of 
the polygon.

The polygon is closed.

Last point of polygon
Auxiliary point
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4-10  To delete an existing measurement point or reference point

Press the right button of the mouse to display a menu and click [Clear point] from it. Alternatively, 

click the [Clear point] button  in the still image operation area. Each click of either button 
deletes the previously entered measurement point or reference point in the reverse order of their 
entries.
A measurement point or reference point can also be deleted by pressing the [Backspace] key.

4-11  To delete all existing measurement points or reference points

When performing a new measurement on the image being displayed, all of the previous mea-
surement results displayed on the image can be deleted.
Press the right button of the mouse to display a menu and click [Clear all] from it. Alternatively, 

click the [Clear all] button  in the still image operation area. In either case, a dialog box ap-
pears to confirm whether or not to delete all the measurement results.
Click [OK] to delete all of the measurement results. All of the measurement points and measure-
ment results being displayed are deleted. If you do not want to delete them, click [Cancel].
All of the measurement results can also be deleted by pressing the [Del] key.

4-12  To save new measurement results

When the position of an existing measurement point or reference point is modified or a new 
measurement point is added, the measurement result is updated or added. These new mea-
surement results can be saved.

Click the [Save results] button  in the still image operation area. The “Save As” dialog box 
appears.
Specify the save destination location and input the filename. Note that the file type is the same 
type as the image file being displayed.
Click the [Save] button in the dialog box. The new measurement results are saved to the stereo 
measurement target image currently displayed.
If the file with the same filename as the filename already exists in the selected save destination 
location, a dialog box appears to confirm whether or not to overwrite the existing file. If you do 
not want to overwrite the existing file, click [Cancel] and change the save destination location or 
the filename.
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 4-13  To save the measurement window as a still image

When the position of an existing measurement point or reference point is modified or a new 
measurement point is added, the measurement result is updated or added. The view of the 
measurement window showing new measurement results can be saved as a JPEG image. The 
still image saved in this way can later be displayed using the standard image display software 
provided with Windows.
Click the [Screen capture] button  in the still image operation area. The “Save As” dialog 
box appears.
Specify the save destination location and input the filename. The file type is JPEG only.
Click the [Save] button in the dialog box. The Stereo Measurement window being displayed is 
saved as a still image in JPEG format.
If the file with the same filename as the entered filename already exists in the selected save 
destination location, a dialog box appears to confirm whether or not to overwrite the existing file. 
If you do not want to overwrite the existing file, click [Cancel] and change the save destination 
location or the filename.

Measurement 
line width
option buttons

[Unit]
drop-down list 
box

[Cursor shape]
select button

Measurement line 
color select button

Reference line 
color select button

Reference line 
width
option buttons

 4-14  To change colors and widths of image-drawing lines

Click the [Options] button  in the still image operation area. The “Options” dialog box ap-
pears.
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The measurement line width (thickness) can be selected from the range between 1 and 5 dots. 
If the stereo measurement target image does not contain any measurement result, the measure-
ment line width is set to 2 dots.
Clicking the [Color Select] button opens the “Color” dialog box.  You can select the color of the 
measurement line as you desire. If the stereo measurement target image does not contain any 
measurement result, the measurement line color is set to yellow.

The reference line width (thickness) can be selected from the range between 1 and 5 dots. If the 
stereo measurement target image does not contain any measurement result, the reference line 
width is set to 2 dots.
Clicking the [Select Color] button opens the “Color” dialog box. You can select the color of the 
reference line as you desire. If the stereo measurement target image does not contain any mea-
surement result, the reference line color is set to light blue.
After selecting the widths and colors of the measurement and reference lines, click the [OK] but-
ton in the “Options” dialog box. Hereafter, the selected widths and colors are used in drawing of 
lines.
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4-15  To view the mask line

For a stereo measurement target image that was measured using the Evident industrial endo-
scope, the line of the mask can be displayed on the still image using the mask line information 
contained in the measurement environment data.

Click the [Options] button  in the still image operation area. The “Options” dialog box ap-
pears. (See the picture on page 51)
Click the [Show Mask Line] check box to put or remove a check mark.
Click the [OK] button in the “Options” dialog box.

 · The precise and correct measurement is not possible if the mask line is notice-
ably misaligned up, down, right or left or rotated.

TIP

4-16  To change the measurement unit

When a stereo measurement target image measured using the Evident industrial endoscope is 
displayed with this software, the measurement results are displayed in the unit used in the mea-
surement (mm or inch). The unit of the measurement result display can be changed as desired.

Click the [Options] button  in the still image operation area. The “Options” dialog box ap-
pears. (See the picture on page 51)
In the [Unit] combo box, select either "mm" or "inch".
Click the [OK] button in the “Options” dialog box.

4-17  To change the cursor shape

The cursor shape can be changed as desired by the user.

Click the [Options] button  in the still image operation area. The “Options” dialog box ap-
pears. (See the picture on page 51)
By the [Cursor shape] select button, select Crosshair Cursor, X Shape Cursor or Pointer Cursor. 
The initial setup of this software is X Shape Cursor.
Click the [OK] button in the “Options” dialog box.
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55 Scaler Measurement window

Following operations are available in the Scaler Measurement window. (Pages for reference)

• Re-measurement (page 56) ; new measurement (page 58)
• Display (page 58); save (page 61) measurement results.
• Zoom the scaler measurement image (page 57)
• Set the reference length (page 58)
• Show or hide the reference line (page 60)
• Modify (page 58) or delete (page 60) the existing measurement point.
• Save a still image by print screen (JPEG only)(page 61).
• Modify colors or widths of image drawing lines (page 62).
• Modify the unit of measurement results (page 63)
• Modify the cursor shape (page 63)
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5-1  Scaler measurement target image

Any image recorded by using the Evident industrial endoscope and meets all of following condi-
tions can be the target of scaler measurement.

• The image is recorded with the optical adapter other than the stereo optical adapter, or with 
the fixed objective lens.

• Model name of the optical adapter used is not "AT220D-IV76" or "AT100DS-IV76".
• Zoom magnification of the image is "X1.0".
• The image is not a record of external input.

When the scaler measurement target image is used, this software can confirm the scaler mea-
surement results performed by the industrial endoscope by re-measuring the image on PC or 
measure the non-measured parts in the still image.
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 5-2  To open the Scaler Measurement window

While the scaler measurement target image is displayed in the Image window, click the [Re-

Measure] button  in the still image operation area. The Scaler Measurement window 
opens displaying the scaler measurement target image.

3

6

4

5

7

2

1

No. Name

1 Title bar

2 Measurement area

3 Measurement mode display

4 Still image operation area

No. Name

5 Measurement result display area

6 Operation instruction area

7 Status bar
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If the Scaler Measurement window is already open and the previous measurement results are 
not saved yet, a dialog box appears to confirm if you want to save the measurement results 
together with the scaler measurement target image currently displayed.
Click [Yes] to save the measurement results. ("5-12  To save new measurement results" (page 
61))
Then, the scaler measurement target image that has been displayed on the Image window is 
displayed newly on the Scaler Measurement window.
If you click [No], the new measurement results are not saved and the scaler measurement target 
image that has been displayed on the Image window is displayed newly on the Scaler Measure-
ment window.

When the scaler measurement target image stored in a removable medium 
such as a CF card, USB memory or SD card is displayed, the medium should be 
kept connected until the scaler re-measurement completes.

 · The next operation to be performed, such as entry of measurement points is 
displayed in the operation instruction area.

NOTE

TIP

5-3  To add a new measurement point

When inputting a measurement point, simply moving the mouse moves the cursor in 1-pixel 
step. Clicking the mouse on the desired position inputs a measurement point at that position.

5-4  To zoom an entire still image

Click the [Image magnification] button in the still image operation area to select the magnifica-
tion. The image magnification can be set to 1X, 2X, 3X or 4X, and the entire still image is zoomed 
according to the setting.
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 5-6  To confirm measurement results and reference length

 5-7  To start new measurement

The measurement results and reference length are displayed in the measurement result display 
area in the Scaler Measurement window as shown below.

 Enter two points to set a reference length.

Two entered 
points

 5-5  To modify the existing measurement points

The positions of existing measurement points can be modified to obtain more accurate mea-
surement results. To change the measurement point position, place the cursor on the desired 
point.
With the cursor at that point, hold the mouse left button pressed and move the cursor to the 
desired point, and then release the mouse left button.
If the measurement point is repositioned, the displayed measurement result changes because 
re-measurement is performed immediately.
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When two points are entered, the distance between two points is measured.

 Enter the reference length.

When two points are entered newly, the distance between two points is measured.

Two entered 
points

Two existing 
points

Newly entered 
point
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5-8  To modify the reference length

5-9  To Show or hide the reference line

5-10  To delete an existing measurement point

5-11  To delete all existing measurement points

An existing reference length can be changed. Press the right button of the mouse to display a 
menu and click [Set reference points] from it. Alternatively, click the [Set reference points] button 

 in the still image operation area. Then, set a reference length according to the procedure 
on page 58 to 59.

Click the [Show reference line] check box in the still image operation area to show or hide the 
reference line.

Press the right button of the mouse to display a menu and click [Clear point] from it. Alternatively, 

click the [Clear point] button  in the still image operation area. Each click of either button 
deletes the previously entered measurement point in the reverse order of their entries.
A measurement point can also be deleted by pressing the [Backspace] key.

When performing a new measurement on the image being displayed, all of the previous mea-
surement results displayed on the image can be deleted.
Press the right button of the mouse to display a menu and click [Clear all] from it. Alternatively, 

click the [Clear all] button  in the still image operation area. In either case, a dialog box ap-
pears to confirm whether or not to delete all the measurement results.
Click [OK] to delete all of the measurement results. All of the measurement points and measure-
ment results being displayed are deleted. If you do not want to delete them, click [Cancel].
All of the measurement results can also be deleted by pressing the [Del] key.
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5-12  To save new measurement results

5-13  To save the measurement window as a still image

When the position of an existing measurement point is modified or a new measurement point 
is added, the measurement result is updated or added. These new measurement results can be 
saved.
Click the [Save results] button  in the still image operation area. The “Save As” dialog box 
appears.
Specify the save destination location and input the filename. Note that the file type is the same 
type as the image file being displayed.
Click the [Save] button in the dialog box. The new measurement results are saved to the scaler 
measurement target image currently displayed.
If the file with the same filename as the filename already exists in the selected save destination 
location, a dialog box appears to confirm whether or not to overwrite the existing file. If you do 
not want to overwrite the existing file, click [Cancel] and change the save destination location or 
the filename.

When the position of an existing measurement point is modified or a new measurement point 
is added, the measurement result is updated or added. The view of the measurement window 
showing new measurement results can be saved as a JPEG image. The still image saved in this 
way can later be displayed using the standard image display software provided with Windows.

Click the [Screen capture] button  in the still image operation area. The “Save As” dialog 
box appears.
Specify the save destination location and input the filename. The file type is JPEG only.
Click the [Save] button in the dialog box. The Scaler Measurement window being displayed is 
saved as a still image in JPEG format.
If the file with the same filename as the filename already exists in the selected save destination 
location, a dialog box appears to confirm whether or not to overwrite the existing file. If you do 
not want to overwrite the existing file, click [Cancel] and change the save destination location or 
the filename.
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 5-14  To change colors and widths of image-drawing lines

Click the [Options] button  in the still image operation area. The “Options” dialog box ap-
pears.

The measurement line width (thickness) can be selected from the range between 1 and 5 dots. 
If the scaler measurement target image does not contain any measurement result, the measure-
ment line width is set to 2 dots.
Clicking the [Select color] button opens the “Color” dialog box. You can select the color of the 
measurement line as you desire. If the scaler measurement target image does not contain any 
measurement result, the measurement line color is set to yellow.

Measurement 
line width
option buttons

[Unit]
drop-down list 
box

[Cursor shape]
select button

Measurement 
line color 
select button

Reference 
line color 
select button

Reference line 
width
option buttons
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The reference line width (thickness) can be selected from the range between 1 and 5 dots. If the 
scaler measurement target image does not contain any measurement result, the reference line 
width is set to 2 dots.
Clicking the [Select color] button opens the “Color” dialog box. You can select the color of the 
reference line as you desire. If the scaler measurement target image does not contain any mea-
surement result, the reference line color is set to light blue.
After selecting the widths and colors of the measurement and reference lines, click the [OK] but-
ton in the “Options” dialog box. Hereafter, the selected widths and colors are used in drawing of 
lines.

5-15  To change the measurement unit

When a scaler measurement target image measured using the Evident industrial endoscope is 
displayed with this software, the measurement results are displayed in the unit used in the mea-
surement (mm or inch). The unit of the measurement result display can be changed as desired.

Click the [Options] button  in the still image operation area. The “Options” dialog box ap-
pears. (See the picture on page 62)
In the [Unit] combo box, select either "mm" or "inch".
Click the [OK] button in the “Options” dialog box.

5-16  To change the cursor shape

The cursor shape can be changed as desired by the user.

Click the [Options] button  in the still image operation area. The “Options” dialog box ap-
pears. (See the picture on page 62)
By the [Cursor shape] select button, select Crosshair Cursor, X Shape Cursor or Pointer Cursor. 
The initial setup of this software is X Shape Cursor.
Click the [OK] button in the “Options” dialog box.



64

Error message Remedy

Measurement unsuccessful. Please try 
again.

Modify the measurement point or input another 
measurement point.

You cannot specify the measurement point 
due to matching unsuccessful.

Move the cursor so that the corresponding point 
or the corresponding point zoom window can be 
displayed in the right side measurement area.

Format of this image is not supported for 
measurement.

A still image obtained with screen capture cannot 
be measured. Measure a measurement target 
image obtained with save results.

Size of this image is not supported for 
measurement.

Measure a stereo measurement target image that 
can be re-measured using this software.

Zoom image is not capable of measure-
ment.

Measure a measurement target image recorded 
without using the zoom function.

Captured image is not capable of mea-
surement.

A still image obtained with screen capture is 
not capable of stereo measurement.. Measure a 
stereo measurement target image obtained with 
save results.

This application does not support this 
image.

This stereo measurement target image is not sup-
ported by this software. Measure a stereo mea-
surement target image that can be re-measured 
using this software.

The 20th measurement point has been 
specified. This point will be set as the end 
point. Now start next measurement.

The measurement in Lines mode or Area mode 
should be performed using no more than 20 
points.

An invalid area is specified. Input points to form a unique polygon.

The 20th measurement point has been 
specified. But you cannot form a region in 
this measurement point.

Input points to form a unique polygon.

Cannot exceed 10 Measurements. When performing more than 10 stereo measure-
ments, open a new stereo measurement target 
image.

Cannot exceed 5 Measurements. When performing more than 5 scaler measure-
ments, open a new scaler measurement target 
image.

You cannot specify a measurement point in 
the same position.

You cannot input a measurement point in the 
same position. Input a measurement point at the 
different position.

The image under measurement is deleted, 
so the measurement window has closed.

Do not disconnect the medium storing the mea-
surement target image file before the measure-
ment completes.

The image being displayed is manipulated, 
so the image window has closed.

Do not remove the medium storing the still image 
file being displayed in the Image window.

66 Displayed Error Messages and Error Remedies
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Error message Remedy

The process cannot access the file be-
cause it is being used by another process.

Close the other window in which this file is being 
used.

Not exist conversion object fie. The convertible file is a still image file of which file 
name does not contain the folder name currently 
selected and also which was recorded using the 
Evident industrial endoscope.

Exceeded the maximum sequence 
number.

Move the file being imported to another folder 
and then do the process again.

The following specified folder(s) not found. 
Do you want to continue?

There is no folder for the target image written in 
the report environment file (.csv) selected in in-
spection object type in Report Generation Step 1. 
Confirm that it is acceptable to generate a report 
without the displayed folder.

Import image file is not found. Files that can be imported are in the BMP, JPEG, 
or TIFF format.

Failed to generate report.() The report items in parentheses ( ) cannot be 
output. Confirm the report template.

The below items cannot be placed when 
its group is not specified.

Report cannot be output because some report 
items do not have a set group. Confirm the report 
template.

Please place location items. Location item has not been set.  
Confirm the report template.

The number of locations do not match the 
number of groups.

Report cannot be output because the number of 
locations does not match the number of groups. 
Confirm the report template.

The number of inspection result related 
items in following groups is not corre-
sponding.

Report cannot be output because the number 
of inspection result related items in displayed 
groups do not match. Confirm the report template.

The number of inspection result related 
items is not corresponding.

Report cannot be output because the number 
of inspection result related items do not match. 
Confirm the report template.

Line feed characters in the template can-
not be used.

Report cannot be output because there are line 
feed characters in the report template. Confirm 
the report template.

The below item cannot be placed because 
its sequence numbers are duplicated or 
discontinuous.

Report cannot be output because sequence 
numbers in displayed report items are duplicated 
or not sequential. Confirm the report template.

The type of inspection result related items 
do not match in all groups.

Report cannot be output because the type and 
number of inspection result related items in all 
groups do not match. Confirm the report template.
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77 Specifications

Item Specifications

System requirements Windows 10 (32 bit or 64 bit); 
RAM: 1 GB or more (32 bit) or 2 GB or more (64 bit); 
HDD available space: 16 GB or more (32 bit) or 20 GB or more (64 bit); 
USB port; Display performance: XGA (1024Hx768V pixel) or higher

Displayable still im-
age file formats

BMP, JPEG, PNG, Exif-JPEG and YCbCr type Exif-TIFF

Displayable movie 
file formats

AVI, MOV and MPG 
(Provided that the PC in use is capable of playing these movie image 
files.)

Playable sound file 
formats

WAV 
(Provided that the PC is capable of playing sound.)

File/folder operations Display, copy, paste, move, search, delete and rename file(s)/folders. 
Drag & drop files. Create new folders.

Thumbnail display Displays thumbnails of the files in the selected folder.

Still image display Whole/original size/2X to 4X of images
Rotation/trimming of images (output to report)
Simultaneous display of two still images

Overlay display of 
auxiliary information

Overlay of auxiliary information including filename, title, date of recording, 
note information and measurement results on still images. Still images 
with overlaid auxiliary information can be saved in JPEG format, copied 
to the clipboard, and dragged & dropped to another location.

Stereo re-measure-
ment

The stereo re-measurement of a still image (except for a Print Screen 
image) recorded by connecting a stereo optical adapter using the 
Evident industrial endoscope is possible on the PC.

Scaler re-measure-
ment

The scaler re-measurement of a still image recorded by using the 
Evident industrial endoscope and meets all of following conditions is 
possible on the PC.
• The image is recorded with the optical adapter other than the stereo 

optical adapter, or with the fixed objective lens.
• Model name of the optical adapter used is not "AT220D-IV76" or 

"AT100DS-IV76".
• Zoom magnification of the image is "X1.0".
• The image is not a record of external input.

Creating a report Microsoft Word 2016
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 Licensing
 { AVC Patent Portfolio License

 { MPEG-4 Visual patent Portfolio License

THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL AND NONCOMMERCIAL USE OF A CONSUMER TO (i) ENCODE VIDEO IN COMPLI-
ANCE WITH THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS 
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NONCOMMERCIAL ACTIVITY 
AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO 
LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMA-
TION MAY BE OBTAINED FROM VIA LICENSING ALLIANCE LLC. SEE https://www.via-la.com/.

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE FOR 
THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING VIDEO IN 
COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD ("MPEG-4 VIDEO") AND/OR (ii) DECOD-
ING MPEG-4 VIDEO THAT WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND 
NONCOMMERCIAL ACTIVITY AND/OR WAS OBTAINED FROM A VIDEO PROVIDER LICENSED 
BY VIA LICENSING ALLIANCE LLC TO PROVIDE MPEG-4 VIDEO. NO LICENSE IS GRANTED 
OR SHALL BE IMPLIED FOR ANY OTHER USE. ADDITIONAL INFORMATION INCLUDING THAT 
RELATING TO PROMOTIONAL, INTERNAL AND COMMERCIAL USES AND LICENSING MAY BE 
OBTAINED FROM VIA LICENSING ALLIANCE LLC. SEE https://www.via-la.com/.
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 · Names of companies and products in this document are 
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